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Introduction

The MedRx Tinnometer represents a new era of ultra-compact screening audiometry for your
office. Compact yet rugged, this PC-Based system is USB powered and supports current ANSI
and IEC audiometric tests. This manual assumes that the system hardware, software
and drivers are installed and working properly. Please refer to the MedRx Tinnometer
Installation Manual for assistance. The Installation Manual is included in the original
Tinnometer packaging in PDF format on the USB Flash Drive.

The scope of this manual is to get you “up and running” with your MedRx Tinnometer. Please
consult the interactive Help System within the software for more detailed information of
features and functionality. To access this tool, press the F1 key at any time, or click the Help
icon or text menu with your mouse. Access these by clicking on the “Help” tab at the top of
the screen, and select “Help Topics”. Select an item from the list in the Index tab and click
“Display”.

nodRxmy b
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The AVANT Audiometer Software Qverview

The AVANT Audiometer software can run stand-alone or from NOAH™ System or the TIMS®
NOAH-Compatible Office System.

Launching the AVANT Audiometer Software
Stand Alone NOAH

favamll AVANT

\_ 7 AUDIOMETER

o Double Click the AVANT e Launch NOAH. _
Audiometer shortcut on your e Launch Avant Audiometer module

Windows Desktop. following NOAH procedures.

Basic Software Options

Several options are available which allow the user to customize the AVANT Audiometer
Software to meet their needs.

Access these options from the File Menuon  The Options may also be accessed

the AVANT Audiometer Main Screen as from the Audio screen by clicking on
shown below. the Options text menu as shown
- below.
m Functicn Help
Print Setup...
Page Setup...
Clear Seszion Data Screening

Advanced Options...

Exit
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f Options ﬂ rOpt’lo ns u

View |Screening Audiometry | MHA/HLS I Tymp I View  Screening Audiometry | MHA/HLS I Tymp I
Amow Buttons —————————————— Default Test:
Pt —————————————— Speech Spectum———————
¥ Vertical Grid [ Canoe Move Up by (dB): IE 3: IManuaI VI
v Horizantal Grid ¥ Speech Sounds Mave Dawn by (dB): |1D 3:
~Sight ———————————— Language: ¥ Auto Sound
Style: | hd < * -
e
Size: |50 Fort Size: (12 v
W Dual Plot Mode Defaut Ear: [Rght v| || D P
aple LUp or neads:
¥ Reverse Ears Plot Curves Width: IMedium vl
¥ Enable Talkback Microphone
¥ Maintain Plot Ratios ¥ Use Plot Antialiasing
ok | Cancel | Hep | 0K | Caced | Hep |
The View tab allows you to set the default The Screening Audiometry tab sets the
appearance of the test environment. look and behavior of the Tinnometer.

f Options M

View ISc:reening.w"\.l.ldi::nwftr).r MHA/HLS Tymp |

Scaling: [Auto -

¥ Auto Switch Modes

v Interpolate Curve

V¥ Allow Muttiple Records

ok | Cancedl | Heb |

If your system has a Tympanometer connected, this tab will assist in configuring the look of
the display.

NOTE: Remember, more information is always available in the Interactive Help System by
clicking the Help Icon or pressing the F1 key.
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Assign Transducers

Option 1: On the Audiometry Options Option 2: You can change transducers by
screen click Transducers to assign specific  Right-Clicking on any transducer icon on
transducers to the audiometer outputs. the Screening screen.

=e Words, Limit: |25 vl ﬁ
‘ ¢¢
=1 P4 200
Mask With
' Change Transducer
— Cloze

Zancel | Hep |

The Transducers dialog box will then appear. Select the appropriate transducer for each
output.

r

Transducers M

Air Conduction: |DD45 j
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Advanced Options

B e o -
m Function Help
Print Setup...
Page Setup...

Clear Session Data

Options...

Advanced Opticns...

Exit

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot technical issues. Access this
screen from the File Menu on the Avant Main
Screen as shown to the right.

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the softwa(e by pressing the F1 key or clicking the Help icon.

Advanced Options

General ]Audm | Video | Tympanometry |

CD-ROM Drive: |D: ~

I Home Directory Calibration Data
Language
Device Manager
Cortrol Panel
System Information
oK Cancel ‘ Help |

The General Tab configures the overall
Tinnometer behavior with respect to other

Windows programs, specifically NOAH.

Advanced Options.

S

Genemw Audic  Video ITympanumeiry]

Otoscope Input

Altemative Input

Device: j

o |

Cancel ‘ Help

If your system has a Video Otoscope, the

Video tab allows you to select the
appropriate device driver.
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Advanced Options

General Audio ]\flden 1 Tympannmatry]

oli T30 - N | Speakers (MedRx AR+ hd

Input Device

L L

Output Micer: | MedPFec AIR=

Input Mixer: ‘

L]

Microphone Gain (dB): |0 -

Set Defaults | Audio Properties ‘

o]

Cancel ‘ Help |

Use the Audio Tab to select the proper audio
device for your Audiometer. This tab also
provides access to the Windows Audio
controls.

Advanced Options. @
General I Audio I Video  Tympanometry I
Tympanometer: _ Available -
,Tl Cancel ‘ Help |

If your system has a Tympanometer
connected, use this tab to identify it and
ensure the driver and software that control it
are correctly installed.



Preparing for Testing

Use the accessories provided with your MedRx Tinnometer. Typical acceptable transducers
are shown on the “Transducer & Accessories” page in the Installation manual. Operator
headsets for use with the MedRx Tinnometer should have 32 ohms impedance and the
speaker power should be at least 50 watts. Air conduction transducers for use with this device
should have an impedance of 10 ohms. The speaker voltage should match the local mains
voltage where the device is used.

The Operator Headset with microphone is used by the device operator to communicate with

the patient. The patient talks to the operator using the Talk-Back microphone.o\

Placing the Earphones on the Patient

High Frequency Earphones (DD450)

1. Place the earphones on the patient’s
head so the center of the earphone
is directly over the opening of the ear
canal.

Adjust the headband so the earphones
remain in place, but be careful not to
make it so tight as to cause patient
discomfort.
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Device Maintenance

Annual re-calibration of the transducers used with the Avant Audiometer is recommended.
There are no user repairable components of this device. Refer to the Installation Manual for
care and cleaning instructions.

Performing Audiometric Testing

The screen shot below shows the all feature controls which are available on the Audiometer main
window. *Depending on the features that have been enabled, on your device, some icon may not
be available.* The sections of the manual that follow explain how to use these tools to perform

hearing evaluations using your MedRx Tinnometer.

File Function Ear Output Audioc  Stimulus  Options...

Tools  Help

‘ Audiamatry ‘ SRT

i B~
wh ‘ Stenger Huw:sm‘@ g

Uncomfortable level

Test Y
1058 aﬁ
| Right Ear
HL[dB ) HL[d8 ] ‘ 500Hz 105dB :¥J
1} 1} ﬁ‘\
10 10 C
d v th \ th
20 - i 20 . f5
il b it \i b il
H a H a
30 i 30 i
] 4 oh g e
b . | b
40 = 40 XO—sh—4
50' de o i 50 Ve tio i “\i
&0 &0 \)—
70 ki)
a0 a0
90 0
il / 11
100+ P e e 100 =
110 110
120 120
125 250 500 750 1k 1.5k 2 3k 4 Bk 125 260 530 780 1k 1.5k 2 3k 4 Ek 8l ‘
Frequency [Hz | Frequency [Hz | ﬁ
K
v | & |
PTA Lefi: 36dB, PTA Right: 36dB '9
#ir Conduction, Al=35%, PTA=36 ¥ SAT WR Aided WR. MCL ucL
Bone conduction, PTA=35 L=ft-
Uncomfortable level ;
#ir Condustion, A=35%, PTAS36 Right: @ @
Bone condustion, PTA=33 Beth: (L/R) @ 1 0

NounhkwnN =
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Test selection tool bar
Ear selection
Output selector
Test Type Selector
Tone Type Selectors
Output Level Potentiometers

Masking interrupter and routing selector

8. No Response button
9. Test Interrupter

10. Back

11. Help

12. Discard

13. Talk Over

14. Legend




Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest
levels they can hear pure tones at a variety of frequencies. These thresholds are plotted on a
standard graph called an audiogram. The AVANT Audiometer software controls the
hardware, stores the data (if running within NOAH or TIMS) and prints a standard audiogram
report. Pure tone Audiometry can be performed via earphones or a Bone Conductor (Bone
Conduction).

Prerequisites:

e Before performing audiometry, careful inspection of the ear canal should be
performed. This is best done with Video Otoscopy. After ensuring the ear canal is clear,
place the appropriate transducer on the patient as shown on page 8 & 9.

Pure Tone Audiometry via DD450

(High Frequency Supra-Aural Headphones)

B
1. From the main Audiometer Window, Click the o button on the right side
menu bar.
2. By default, the o button will be selected once you enter the main

Audiometry Screen. Other default settings (based on typical clinical practice and
procedures) are:

a. RightEar

b. AC (Air Conduction)
c. Tone Stimulus

d. Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that
they should signal (raise their hand, press the patient response button, etc.) as soon as
they hear it. Itis helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left
ear).

-] Test
5. Present a tone at 60 dB by pressing the space bar or clicking the [+ button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up
arrow on your keyboard and present again.

7. Repeat step 6 until the patient signals that they hear the tone.

8. When the patient signals they hear the tone, decrease the level by 10 dB and present
the tone again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times
with the level ascending.
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10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5

through 8 to establish the threshold at 2000 Hz.

NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater

than) the threshold at 1000 Hz, repeat steps 5 through 8 at 1500 Hz (the
“half octave” between 1000 Hz and 2000 Hz).

11. Repeat steps 5 through 8 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz.

12. Repeat steps 5 through 11 in the opposite ear.

NOTE: The software automatically calculates the 3-frequency Pure Tone Average

(PTA) which is displayed above and inside the legend as follows:

PTA Right: 60dB

e 2 Conduction, Al=0%, PTA=G0

Tinnometer

Purpose of the Tinnometer

Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to
mimic the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment.
Tinnitus Assessment increases patient rapport with the clinician when an equivalent tinnitus
sound can be created. The Tinnometer can accurately create tinnitus sounds for fast and
reliable tinnitus assessment. All test results should be used to help counsel the patient on
their specific tinnitus and what the assessment has found.

The Tinnometer test was developed to:

1.

N o ok~ WD

Break away from the traditional limitation of tinnitus assessment with an audiometer
Produce accurate and flexible sounds that mimic patient tinnitus

Provide extended frequency ranges to more accurately match tinnitus sounds
Decrease the time needed to complete a tinnitus assessment

Standardize reporting needed when completing tinnitus assessment

Allow clinicians to save and recall prior tinnitus assessments

Provide general guidelines for implementing results into tinnitus sound therapies
provided by leading hearing aid manufacturers
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Performing the Tinnometer Testing:

e (lickthe Tinnometer button from
@ the main Avant Audiometer main
screen.
Tinnometer

The following screenshot shows the key features of the Tinnometer:

1. Toggle Switch to Start/Stop stimulus 4. Buttons used in determining tinnitus
2. Sliders to control frequency, match, threshold and minimum

bandwidth, slope and tempo of the masking level

stimulus 5. Area where description of items will
3. Slider to control the intensity of the be displayed

stimulus 6. Channels designed to present

multiple types of tinnitus sounds

7. A graphical display of the sounds being played for the patient. Stimulus and
Audiogram (if done within Avant or Noah) are display in dB SPL

Lowieq g
-
oy

I} - -] =

® a3
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Interactions with the patient are controlled as follows:

1. Patient response switch indicator 4. Undo
2. Patient monitor microphone 5. Toggle help section
3. Talk forward 6. Return to Avant

There are 3 Steps needed for Tinnitus Assessment with the
Tinnometer

—_

Identify patient’s tinnitus by frequency, bandwidth, slope and tempo

2. Lower the identified tinnitus until patient threshold is reached

3. Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if
needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60
seconds to ensure masking is achieved.

Step 1: Identify Patient’s Tinnitus

AedRx - Speakers (MedRx ARC Audio - A] - linnoMeter 1. Start by selecting the tinnitus type that
Audio Qutput [ Tinnitus Type | Questionaire  Informati has been described by the patient. This is
Ringing an approximation of the tinnitus sound
. . Whisting your patient hears. Tinnitus type will
rE provide a starting frequency, bandwidth
and slope to help speed up testing time.
Buzzing
Humming

2. Use the stimulus start/stop toggle to
present the selected signal to the patient.
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Frequency

20Hz 50Hz 125Hz 250Hz 500Hz 1k

CI———

1O

2k 4k 8k 120
Band
100
- Orm—i

= e e A G s S

16k 24k

"

~ Tinnitus
=

%

[l o

—
0

hreshold

i

3. Use frequency slider to match the

pitch of the patient’s perceived
tinnitus

4. Use volume slider to match patient’s

perceived intensity of tinnitus

5. Adjust bandwidth, slope and tempo
(for pulsating tinnitus or prevention of

adaptation) as needed

8.

Buttons to allow greater flexibility in
bandwidth and slope of tinnitus.
Allows the addition of high/low
frequency sounds independently
Allows for independent right/left
volume control

Press Tinnitus Level button once the
patient’s tinnitus is matched

Step 2: Find Identified Tinnitus Threshold

Level
Threshold

0 -

Volume .

60 Tinnitus
Level

40 =

Level
Threshold

MANIL

22
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1.

2.
Step 3: Masking Tinnitus for 60 Seconds

1.

Use down arrow on your keyboard to
lower stimulus until patient states
they are no longer able to hear the
tinnitus.

Click Threshold Level button.

Use volume slider to increase
intensity of the stimulus until the
patient states they are no longer able
to hear their tinnitus.

NOTE: Lower levels of masking may be
achieved by increasing bandwidth of
the masking stimulus. Pulsating the
masking noise can prevent tinnitus
adaptation.

Press the MML button and continue
presenting stimulus until 60 second
countdown ends.

If patient begins to hear their tinnitus
within the 60 seconds, raise intensity
until masking is achieved and repeat
number 2.
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Tinnometer Modulation Tab

The Tinnometer modulation tab is designed to simulate sound generators
when hearing aid demonstrations cannot be performed. The following are
controls used in Modulation.

[]Random E
[ Music 20 I‘
[[]Ocean modulatic o
@ - e I | — =
eed maodulation I] quency '“n(lu\allJ]II T
1. Type of modulation Sound 3. Frequency of modulation
2. Speed of modulation 4. Modulation volume range

To use the Modulation features within Tinnometer, you must first complete
the three steps involved with tinnitus assessment. Once tinnitus assessment
is complete, you can use modulation by:

R @ 1. Activating the channel in
which the tinnitus
O6dB 484229 Hz ©6dB assessment was performed.
H6dB Threshold Level 56dB
451 Relative Tinnitus Level 45L
105L Relative MML 105L
Low High
Band 015 015
in octave
slope 100 100
in %

2. Enter the modulation tab on
the right side of Tinnometer
software.
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[[1Random

[ Music 20 I‘
[ 1]

[1O0cean modulatic :

1 (| | i 1

) . - ! Level modulation

3. Adjust the modulation stimulus with sliders as a counseling tool for the
patient.

Tinnometer Audiometry Scan

The Tinnometer Scan tab is designed for various forms of air conduction
audiometry. There are three types of audiometry that can be performed with
Tinnometer. You can access the forms of audiometry with the buttons
located by the number 1 in the image below.

‘ BEKEZY |

|
|
‘ Scan |
. 7\
| |

Audiogram |
|
I ]

Tinnometer Residual Inhibition (RI)

The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a
patient’s tinnitus. The controls in the RI tab are as follows:

nnnnnnnnnnnnn 1. Scale from 0-10 of
tinnitus bothersome
level
2. Timer to begin
stimulus

3. Tracking of patient’s
tinnitus bothersome
level as a function of
time
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A complete tinnitus assessment must be performed prior to performing
testing in the RI tab. Once tinnitus assessment testing is completed, optional
residual inhibition testing can be performed with the following steps:

56dB Threshold Level 56dB

4SL  Relative Tinnitus Level  4SL|

10SL Relative MML 1051
Low High

Band 0.15 0.15

in octave

slope 100 100

in %

ad

i
. -

OLOROYOXO)
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. Activating the channel in

which the tinnitus
assessment was performed.

. Select the RI tab on the

right side of the Tinnometer
software.

. Ask the patient the

bothersome level of their
tinnitus from 1 to 10 and
mark their response.

. Click the stop watch to

begin the masking stimulus
(stimulus to play for 60
seconds).
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You will hear a masking neoise for 1 minute
Then the noise will suddenly stop
The patient will have to redefine his discomfort about every 30 seconds.

5. Stimulus will play for 60 seconds and automatically stop at the 60 second
point.

) ‘ , - Al EKP
PPPOPOPIOO®

6. When the stimulus stops the patient must redefine their tinnitus bothersome
level every 30 seconds. The bothersome level should decrease upon the
stimulus stopping and will increase with time.

7. The test continues until the bothersome level returns to pre-test level.

Tinnometer Report Printing

The Tinnometer has four reports available for printing: tinnitus assessment

report, manufacturer guidance report, questionnaire report and a channel

report.

The following are common features found across reports:

QMedri ™ Speaker 1. To generate your report,
N::u:ut Tinnitus type  Questionaire  Information  Lan Select w p ri nter . ” frO m
open O the File menu.
Save
Manufacturer Guidance  »
Print v printer ...

Exit
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2. Select the paper style
us you are printing.

3. Confirm all patient
information is correct.

==.

4. Choose your print
preferences.

5. Change the zoom of your
print preview.

.

6. Print your Report.

Tinnitus Assessment Report

Tinnitus assessment reports are able to be generated after completing the
three steps to tinnitus assessment. Once all steps are complete you are able
to print a report

@l’Mfd“*-SM 1. To generate your tinnitus
-F' 0 t Tinnitu: tionai I i L
e utpu innitus type  Questionaire nformation an assessment report, Select

Mew

open O “printer ...” from the File

Save menu.

Manufacturer Guidance b

Print J printer ...

Exit
Channel 1 2. The “Channel” reports are the
Al channels | tinnitus assessment reports.
Graph Channel 1 Select the channel used for
oo Chonn 3 testing or All Channels when
Graph Channel 4 multi-channel testing is

completed.
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Haniek sl 3. Use the drop down box to
I = select a diagnosis for the

H%3.11 Tinnitus, right ear .
H33.12 Tinnitus. lef ear patient.

H%3.13 Tinnitus, balateral

|H93.19 Tinnitus, unspecified ear

Comments 4x60 characters 4. Comments can be entered in 4

separate lines with a
maximum of 60 characters.

5. Print the Report.

Manufacturer Guidance Report

Manufacturer guidance reports are designed to provide hearing aid sound
therapy guidance to a clinician based on tinnitus assessment results. Sound
therapy is an option to tinnitus treatment. We encourage all clinics to
develop a tinnitus treatment protocol that is in line with their tinnitus
treatment goals. Manufacturer guidance generated by the Tinnometer is
designed to be a starting point in sound therapy and each patient may differ
in preferred sound.

Manufacturer guidance reports are able to be generated after completing the
three steps to tinnitus assessment. Once all three tinnitus assessment steps
are complete you are able to print a report.

1. Select the manufacturer that
e D you would like to have printed
in your report.

Manufacturer Guidance  + Oficon
,

Print Phonak

Exit Signia

Bernafon
Sonic
Beltone

QeI Speakers G NG 2. To generate your tinnitus

Qutput  Tinnitus type  Questionaire  Information  Lan
New 0 assessment report, select
Open “printer ...” from the File
= menu.

Manufacturer Guidance v
Print 3 printer ...
Exit
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Channel 1
Channel 2
[RUR=IE I
Hearing Aid Guidance

rerEpC T
Graph Channel 2
Graph Channel 3
Graph Channel 4

Diagnosis Code

H%3.11 Tinnitus, right ear
H33.12 Tinnitus, left ear

H33.13 Tinnitus, bilateral
|H%3.19 Tinnitus, unspacified ear

Comments 4x60 characlers

Graph Channel Report

. Select “"Hearing Aid Guidance’

4

from the list of reports.

Use the drop down box to
select a diagnosis for the
patient.

Comments can be entered in 4
separate lines with a
maximum of 60 characters.

. Print the report.

Graph channel reports will print a patient report which displays an image of
the patient’s tinnitus with QR codes for YouTube videos that play a wind
modulation noise nearest to their tinnitus. To generate the report you must:

D MedR - Speakers (3~ USE Ao DEviEa]~ TrroVieir Ve

Qutput  Tinnitus type  Questionaire  Information  Lan

Mew
Open o

Save
Manufacturer Guidance b

Print * printer ...
Exit

D-0117977-C 01/2019

1.

To generate your tinnitus
assessment report, select
“printer ...” from the File
menu.
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Channel 1 2. Select “"Graph Channel” from
Channel 2

All Channels the list of reports. Select the

0 channel number which you
raph Channel 1 ’ ,

Graph Channel 2 used to match your patient’s

Graph Channel 3 . .

Graph Channel 4 tinnitus sound.

3. Print the report.

Questionnaire Report

Questionnaire reports will only show as an option once the questionnaire has
been completed. Once a questionnaire has been completed and you are
ready to print a report you must:

@ MedRx - Speakers (3~ USB Agio Device) - TinnoMeter Me P
1. To generate your tinnitus
New 0 assessment report, select
open “printer ...” from the File menu.
Save
Manufacturer Guidance 3
Print * printer ...
Exit
Channel 1 2. Select the name of the
All Channel i i
plChamels e qu_estlonnalre you want to
Graph Channel 1 print from the list of reports.

Graph Channel 2
Graph Channel 3

|THI

3. Print the report.
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Printing

Printing within the Avant Audiometer software is very simple.

Functinn Ear Output Aud

Open
Save

Clear Sezzion Data

Page Setup...
Print Setup...
Print Preview
Print...

Go Back Ctrl-Back
Exit Alt-F4

D-0117977-C 01/2019
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From the File menu, click one of the following options:

Page Setup - Allows you to set margin sizes and the
default text header for your reports.

Print Setup - selects the printer you want the report
to be sent to.

Print Preview - Shows you what your report will look
like before you print it.

Print - Sends the report to the printer. This option
opens the Windows Print dialog which allows the user
to select any installed printer and modify the
properties (quality, number of copies, etc.) for the
print job.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and workmanship for
one year from the time of purchase. If this system fails to perform as specified during this

period, the purchaser is responsible for calling MedRx at (888) 392-1234 or (727) 584-9600.

The company's representative will advise the owner to either return specific components
or the entire system to:

MedRYx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for the
repair or return shipping, provided the system is one year old or less and has not been
misused, abused or damaged. Such damage includes, but is not limited to, dropping,
exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential or
incidental damages or for breach of any express or implied warranty. Except to the extent
of applicable law, any implied warranty, merchantability or fitness of this product is
limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the purchaser's
request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this product
which is not pre-approved by MedRx, Inc. Approved software includes NOAH™ and HIMSA
approved hearing aid manufacturer programming modules for fitting hearing aids.

MedRx, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on the
system causing a conflict, MedRx will service the product for a fee to be determined at the
time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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